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Preface 1
Purpose of this documentation   

This documentation provides you with a full overview of the topics relating to the use of high-
precision time stamping: 

● Required components

● Interaction of the components

● Configuration of the components

The first section gives you an overview of the option and use cases for high-precision time 
stamping and is intended for the following readership:

● Future users of SIMATIC PCS 7

● Persons responsible for deciding on the use of a control system

● Sales personnel and system configuration engineers either within Siemens or belonging to 
other companies

The subsequent sections show the configuration and parameter assignments for high-
precision time stamping and is intended for persons involved in the following occupations:

● Conceptual design of PCS 7 solutions

● Device and system programming

● Configuration and commissioning

● Servicing

Options for accessing PCS 7 documentation
 

 Note
PCS 7 Readme

The information in the PCS 7 Readme in the Internet takes precedence over all the PCS 7 
manuals. Read this PCS 7 Readme carefully; it contains important information and 
amendments to PCS 7.
● The PCS 7 Readme on the Process Control System; SIMATIC PCS 7 DVD contains 

important information about PCS 7 and takes precedence over the supplied PCS 7 
documentation.

● After installation of PCS 7, you will find the document Process Control System PCS 7; 
PCS 7 Readme in the submenu SIMATIC > Product information > <Language>.

 

As of PCS 7 V8.0, you receive basic PCS 7 system documentation with the Process Control 
System; SIMATIC PCS 7 DVD. 

The PCS 7 Internet site http://www.siemens.de/pcs7-dokumentation (www.siemens.com/pcs7-
documentation) provides convenient access to the complete PCS 7 documentation. You can 
find the following for the latest PCS 7 versions:

High-precision time stamping (V8.0 SP1)
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● In the section "Hardware manuals for SIMATIC PCS 7 ..."

– The manuals for components approved for a PCS 7 version

● In the section "Software manuals for SIMATIC PCS 7 ..."

– The complete system documentation

– The separate setup program for PCS 7 documentation and the PCS 7 help system for 
download. After the installation of the setup program, you can find the documentation 
at the following locations on the engineering station:
- As online help (CHM file) for the SIMATIC Manager application
- As a PDF file in the Windows Start menu with the SIMATIC documentation

– The complete documentation for PCS 7 as a Manual Collection

Required basic knowledge
General knowledge in the area of automation engineering and basic knowledge of PCS 7 is 
required to understand this documentation. It is also assumed that the reader knows how to 
use computers or other equipment similar to PCs (such as programming devices) with the 
Windows operating system. 

The configuration manuals and the Getting Started documentation for PCS 7 will provide you 
with basic information regarding the use of PCS 7.

Conventions
In this documentation, the names of elements in the software interface are specified in the 
language of this documentation. If you have installed a multi-language package for the 
operating system, some of the designations will be displayed in the base language of the 
operating system after a language switch and will, therefore, differ from the designations used 
in the documentation.

Changes compared to the previous version
Below, you will find an overview of the most important changes in the documentation compared 
to the previous version:

PCS 7 V7.1 or later

● The IMDRV_TS and MSG_TS blocks replace the IM_DRV in the PCS 7 library. Message 
texts are retained following a future update of the library.

● High-precision time stamping using blocks from the Advanced Process Library (APL) 

● High-precision time stamping with redundant signal acquisition

● You will find information about time synchronization in the Process Control System PCS 7; 
Time Synchronization function manual.

Preface
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Basics of Time Stamping 2
2.1 Basics of High-precision Time Stamping

Introduction                 
This documentation describes the time stamping function for digital input signals. Users can 
activate time stamping in their system configuration and display the time information in their 
monitoring system.

Definition
The following is meant when referring to time stamping in this documentation: 

The assignment of time information with a high degree of accuracy about the state changes 
of an acquired process signal. 

The detection of changes in digital input signal states and the assignment of time information 
are performed by SIMATIC components. 

Application
Possible applications for high-precision time stamping are:

● Accurately-timed detection of problems in process-related equipment. Time stamping 
enables you to explicitly identify signals that indicate the cause of the failure of a process 
unit.

● Analysis of system-wide interrelationships

● Detection and reporting of the sequence of time-critical signal changes

● Time-precise acquisition of signal changes in fail-safe devices

Requirement
The time must be synchronized on all the devices belonging to the system. The devices are 
connected to a time master for this purpose.

Precision
The following applies to high-precision time stamping:

● If process signals are acquired from a separate PROFIBUS DP master systems and results 
arrive simultaneously at the input module, the time stamps of the resulting messages in the 
HMI system differ by maximum x milliseconds (see table below). The achievable precision 
depends on the I/O modules used.

● The signals receive a time stamp regardless of whether the PROFIBUS DP master systems 
are located in one or more SIMATIC 400 stations.

High-precision time stamping (V8.0 SP1)
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Achievable 
precision

I/O Description

1 ms ET 200M With ET 200M, you can acquire signal changes with selected digital 
input modules with an accuracy of 1 ms.
Additional information on this topic is available in section "High-
precision time stamping with 1 ms accuracy (Page 21)".

10 ms ET 200M With ET 200M, you can acquire signal changes with selected digital 
input modules with an accuracy of 10 ms.

20 ms ET 200iSP With ET 200iSP, you can acquire signal changes with selected digital 
input modules with an accuracy of 20 ms.

20 ms ET 200M During fail-safe signal acquisition with ET 200M, you can acquire 
signal changes with selected digital input modules with an accuracy 
of 20 ms.

Resolution
The displayed resolution of the time is 1 ms (regardless of the precision).

Advantage
The high-precision time stamping does not depend on cycle times.

Property
The high-precision time stamping can only be used for digital input modules.

Additional information
For additional information about released digital input modules, refer to the section "Systems 
and components (Page 23)".

Basics of Time Stamping
2.1 Basics of High-precision Time Stamping
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2.2 Time stamping of signal transitions

Time-precise acquisition 
The use of time stamps makes it easier to analyze the causes of problems.

Example

If a boiler used to produce steam fails, this event causes a surge of messages:

● The temperature and pressure fall below a specified limit value, the flame monitor responds, 
the next plant unit signals "steam low", etc.

● To determine the actual cause of the failure, the first message in this surge of messages 
must be identified (for example, "gas pressure too low").

● Following the failure of a plant unit, a large number of messages will arrive at the monitoring 
stations within the same second. A resolution of 1 second for the message time is 
inadequate. You can use time stamping to selectively detect the signals that can potentially 
lead the shutdown of the boiler with a resolution in the millisecond range. This option gives 
the operator the opportunity of finding the cause of the event.

Plant-Wide Interrelationships
A further aspect of 10 ms time stamping is the determination of interrelationships between 
units in a plant. 

Example

High-precision time stamping is implemented throughout the plant. Relevant signals of the 
individual automation systems configured with PCS 7 can be compared (for example, the 
signals of a filling station with the signals of a dosing station originating from another AS).

By comparing the time stamps of relevant signals throughout the plant, a momentary quality 
impairment in a unit can be traced to an event in another unit.

Basics of Time Stamping
2.2 Time stamping of signal transitions
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2.3 The time stamping process

Description       
The following table describes the time stamping sequence.

The digital inputs of a module in the distributed I/O station (ET 200M, ET 200iSP) are monitored 
for signal transitions. 

Step Who/Where? What?
1 IM The interface module IM (IM 153-2, IM 152-1) stores the signal state change.
2 IM The interface module IM (IM 153-2, IM 152-1) stores the information about an "incoming 

event" with the current time in a message list (in the IM). 
Features:
● The time resolution of the time stamping is 1 ms.
● Special messages are also saved in the message list (events influencing message 

processing).
● An IM stores up to 240 messages. These messages are processed in data records. A 

data record contains a maximum of 20 messages.
3 IM The interface module IM (IM 153-2, IM 152-1) triggers a hardware interrupt on the DP 

master (for example, SIMATIC station S7-4xx) if one of the following events occurs:
● A message list (data record) in the IM is full.
● There is at least one message in a message list after 1 second.

4 CPU The CPU reads the reaction to the process alarm (OB 4x) from the data record.
5 IMDRV_TS The driver block IMDRV_TS reads the data records of the interface module (IM 153-2, 

IM 152-1) and transfers the information to signal the APL block Pcs7DiIT . The information 
of the input signal is stored temporarily in the block Pcs7DiIT .
The message texts are saved to the signaling block by default (you can find additional 
information on this in the "AS process control messages for time stamp faults" section).

6 EventTS The APL block EventTS reads the time stamp via the block Pcs7DiIT from the output of 
IMDRV_TS.
The EventTS block sends the message to the operator station. The message text depends 
on the configuration (see the paragraph "Additional information").
The configuration in HW Config defines which signal transition 0 > 1 or 1 > 0 is to be reported 
as "INCOMING". The "OUTGOING" message is generated when the state reported by 
"INCOMING" changes. 
The signals with a time stamp are entered without gaps and in ascending chronological 
order in the message list of the operator station.

7 Synchronization All the operator stations and SIMATIC stations used in the system must be supplied with 
the same time:
● The time master regulates the time synchronization for time stamping.
● Various time masters are available, for example:

– "SICLOCK TC 400"
– "Real-time transmitter for Industrial Ethernet"

Basics of Time Stamping
2.3 The time stamping process
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Additional information
● Section "How to configure messages with blocks of the PCS 7 Advanced Process Library 

(APL)  (Page 60)"

● Operating Instructions SIMATIC; Distributed I/O Device ET 200M
● Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP

Basics of Time Stamping
2.3 The time stamping process
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2.4 The time stamping process in the interface module

Principle
The figure below shows how signal transitions are time stamped in the interface module 
(IM 153-2, IM 152-1).

Basics of Time Stamping
2.4 The time stamping process in the interface module
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Basics of Time Stamping
2.4 The time stamping process in the interface module
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 Note
Startup synchronization

A time stamp with the value "01.01.1984" will be sent if the interface module is not 
synchronized during startup. The events are correctly assigned a time stamp following the 
automatic configuration (synchronization) by the CPU.

 

Basics of Time Stamping
2.4 The time stamping process in the interface module
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Structure 3
3.1 System planning and configuration

The following rules apply to the configuration of high-precision time stamps in addition to the 
configuration rules of PCS 7 (see documentation SIMATIC; Process Control System PCS 7; 
Engineering System). 

Introduction
The following rules are intended for the optimization of the plant with regard to high-precision 
time stamps. 

Rules
● Configure time stamping for relevant signals only in SIMATIC stations. High precision time 

stamps are used for error analysis and should not be employed for process control. 
Additional information on this topic is available in the section "Basics of High-precision Time 
Stamping (Page 7)".

● High-precision time stamping can only be configured for digital inputs.

● Check the applicability of the modules. 
Additional information on this topic is available in the section "Systems and components 
(Page 23)".    

● When planning your system and during configuration, ensure that the signals to be acquired 
are distributed uniformly throughout the system.

● Configure a maximum of 8 modules that can process data records for each PROFIBUS 
master system (IM, CP, FM).

● Configure the ET 200 stations as uniform as possible. The measurement results will be 
comparable with a uniform configuration. 
Examples:

– Physical - cables and encoders (switches, sensors, etc.)

– Hardware - module types

– Configuration - for example, identical delay times for the inputs

● Configure only digital inputs in these ET 200 stations.

High-precision time stamping (V8.0 SP1)
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● Do not configure technological functions in these ET 200 stations; this omission will assure 
the deterministic characteristic of the plant.

● Plant-specific configuration:
Design the assembly of an ET 200 station in such a way that, taken  together, the digital 
inputs used will generate a limited number of signal changes for the plant even in critical 
situations. Individual defective encoders or massive switching operations (shutdown of a 
plant, for example) often generate a large number of signal changes. PCS 7 ensures that 
the cause of the event can be located in these situations. A transient buffer overflow that 
can occur with a plant failure is not critical, because the error messages causing it are 
recorded in the archive.

Structure
3.1 System planning and configuration
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3.2 Hardware Configuration

Introduction
You use the distributed I/O based on ET 200M or ET 200iSP to acquire the signals.

This section provides an example of a hardware configuration needed for time stamping.

Example system with time stamping
The following figure shows an example of a system configuration with time stamping.

Example plant with time stamping in the fault-tolerant automation system
You can also use the time stamping function together with an S7-400H and distributed I/O:

● With an ET 200M, you can create a redundant configuration even to the sensor (fully 
redundant distributed I/O).

● With an ET 200iSP, you can connect to a redundant PROFIBUS DP (redundant 
interconnection).

Below you will see an example of a system using ET 200M.

Structure
3.2 Hardware Configuration
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 Note
Redundant signal acquisition

The required resources depend on the number of inputs, not the number of redundantly 
acquired signals. 

 

Additional information
● You will find information about time synchronization in the Process Control System PCS 7; 

PCS 7 Time Synchronization function manual.

● You can find information about the IM 153-2 interface module in the manual Distributed I/
O Device ET 200M.

● You can find information about the IM 152-1 interface module in the manual Distributed I/
O Device ET 200iSP.

● You can find information about the redundant configuration of a distributed I/O in PCS 7 in 
the following documentation:

– Manual Process Control System PCS 7; Fault-tolerant Process Control Systems
– Manual Programmable Controller S7-400H, Fault-Tolerant Systems

Structure
3.2 Hardware Configuration
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3.3 Special features of the interface module

Introduction        
PCS 7 ensures that the cause of an event can be located in critical situations. This statement 
also applies if the message buffer of an interface module (IM 153-2, IM 152-1) becomes 
overloaded due to a signal surge and too many signals constantly being reported. Read section 
"System planning and configuration (Page 15)". 
Constant overload can result in the loss of messages.

Message surge
When "unusual" events occur (for example, failure of a plant unit), signal transitions can occur 
almost simultaneously. 

This behavior can be explained by analyzing the technological interrelationships.

Example

The frequency of signal transitions in a system can be projected as follows: 

● On average, approximately 2% of the signals change per second.

● In the worst case (such as the failure of a plant unit), approximately 30% of the signals 
change state per second.

Message loss
If all the time-stamped signals of a system are collected on one ET 200 station, messages can 
be lost on the relevant interface module when "unusual" events occur. The message loss is 
displayed according to the cause using AS process control messages (you can find additional 
information in the "AS Process Control Messages for Time Stamp Faults (Page 63)" section).

Example for 10 ms time stamping

A system with ET 200M has 1,500 digital signals in its final configuration:

● Based on the projection, 450 signals per second can change in this system in the worst 
case.

● If numerous signals with high-precision time stamping are configured in an ET 200M station, 
for example, when there are 8 SM 321 digital input modules each with 16 inputs, messages 
can be lost due to the following reasons:

– Other system-internal messages are generated in addition to the process messages 
(you can find additional information in the section "AS Process Control Messages for 
Time Stamp Faults").

– The following processing levels (interface module, IMDRV_TS blocks, AS message 
processing, MSG_TS blocks and OS message processing) require more time to 
evaluate process messages (slow execution cycle of the blocks is set).

Structure
3.3 Special features of the interface module
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Additional information
● Operating Instructions SIMATIC; Distributed I/O Device ET 200M
● Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP

Structure
3.3 Special features of the interface module
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3.4 High-precision time stamping with 1 ms accuracy

Configuration rules  
● Synchronize the automation system via a time master, such as SICLOCK TC 400.

● Use the following modules in the automation system:

– Interface module IM 153-2 (e.g 6ES7 153-2BAx1-0XB0, see "Distributed I/O (Page 26)" 
section)

– Digital input modules of the ET 200M

● Use the 6ES7 321-7BHxx-0AB0 digital input module for high-precision time stamping.

● Install the digital input module (6ES7 321-7BHxx-0AB0) for processing the input signals 
with high-precision time stamping gapless starting with slot 4.

● Configure an identical input delay for all digital inputs with high-precision time stamping to 
a minimum value (100 microseconds).

● Leave the process interrupts deactivated.

● When configuring the plant, ensure that there is no repeater in the signal path between the 
CPU of the automation system and an ET 200M in the DP master system on which the 
digital inputs are acquired with high-precision time stamping.

● Do not evaluate the digital inputs with high-precision time stamping before the startup time 
of ET 200M has expired (at least 10 seconds).

● Use appropriate sensors for acquiring the signals.
 

  Note

Keep the properties of the sensors in mind.

Input signal junctions can have differing effects on the accuracy of the time stamping. The 
varied response is effected by such criteria as:
● Ramp times
● Spikes

 

Validity
The accuracy of the high-precision time stamping with 1 ms accuracy applies per DP master 
system. 

 

 Note

The accuracy of the high-precision time stamping between several DP master systems with 
an accuracy of 1 ms is 10 ms.

 

Structure
3.4 High-precision time stamping with 1 ms accuracy
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Restriction
The following events may be the cause for temporary degradation of the accuracy of the high-
precision time stamping:

● Processing of diagnostic results

● Firmware update

● Reading identification and maintenance information (I&M data)

● Other acyclical services

Structure
3.4 High-precision time stamping with 1 ms accuracy
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Systems and components 4
4.1 Overview: Systems and components

Introduction
This section presents the systems and components required for time stamping of digital input 
signals.

Systems
The HMI system in the PCS 7 process control system is an operator station. The automation 
system in the PCS 7 process control system is a SIMATIC station.

Components
The following components are used for converting time stamping of digital input signals:

● SIMATIC station (Page 24) 

● Communication modules (Page 25) 

● Distributed I/O (Page 26) 

● IMDRV_TS block (Page 28) 

● EventTS block (Page 29) 

● Time master (Page 30) 
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4.2 SIMATIC station

SIMATIC stations   
You can use S7-400 and S7-400H series CPUs in the SIMATIC stations for processing 
messages and forwarding them to the operator stations.

Systems and components
4.2 SIMATIC station
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4.3 Communication modules

Communication modules            
You can use the following communication modules for time stamping:

● CP 443-1

● CP 443-5 Extended
 

  Note

You can use the PROFIBUS DP connection of the CPU instead of the CP 443-5 Extended . 
 

Properties

Property CP 443-1 CP 443-5 Extended
Used as ... ... interface to the plant bus ... interface to the distributed I/O device
Used to 
establish 
connection 
between ...

... SIMATIC station and operator station ... SIMATIC station and distributed I/O 
device
CP 443-5 Extended forwards the 
stamped messages transferred via the 
PROFIBUS DP (fieldbus) to the CPU. 

Connection to 
bus system

Industrial Ethernet (plant bus) PROFIBUS DP (fieldbus)

Order No. 6GK7 443-1EX20-0XE0
6GK7 443-1EX30-0XE0

6GK7 443-5DX05-0XE0
6GK7 443-5DX04-0XE0

Mounting In the SIMATIC station slots in the rack 
(universal rack - UR) )

In the SIMATIC station slots in the rack 
(universal rack - UR) )

Systems and components
4.3 Communication modules
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4.4 Distributed I/O

Distributed I/O         
Time stamping can be configured with the following distributed I/O devices:

● ET 200M

● ET 200iSP

The following modules are used in the distributed I/O device to acquire signals:

● Interface module for PROFIBUS DP for preprocessing the signals

● Digital input modules for detecting signal transitions
 

  Note
Discontinued modules

The modules that can currently be ordered are described in this documentation. 

The following applies when using modules approved for high-precision time stamping in 
past versions of PCS 7:

Verify their continued use in PCS 7. You can find additional information on this in the 
documentation Process Control System PCS 7; Released Modules.

 

Interface modules for PROFIBUS DP   

Distributed I/O 
device 

Module Order No. Product version Precision

ET 200M IM 153-2 6ES7 153-2BA02-0XB0 All 1 ms (20 ms for fail-safe signal 
acquisition)

ET 200M IM 153-2 6ES7 153-2BA82-0XB0 All 1 ms (20 ms for fail-safe signal 
acquisition)

ET 200iSP IM 152-1 6ES7 152-1AA00-0AB0 1.0 
(>=2.0 for 
redundant 
interfacing)

20 ms

Systems and components
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Digital input modules   

Distributed I/O 
device

Module Order No. Used as 

ET 200M SM 321 6ES7 321-7BH01-0AB0
Accuracy of 1 ms

Module for acquisition of process signals:
16 electrically isolated inputs (24 V DC) and 
diagnostic messages, redundant signal acquisition 
possible

ET 200M SM 321 6ES7 321-7EH00-0AB0
Accuracy of 10 ms

Module for acquisition of process signals:
16 electrically isolated inputs (24-125 V DC) and
diagnostic messages, redundant signal acquisition 
possible

ET 200M SM 321 6ES7 321-7RD00-0AB0
Accuracy of 10 ms

Module for acquisition of process signals:
4 inputs (NAMUR), suitable for hazardous areas, 
redundant signal acquisition possible

ET 200M SM 321 6ES7 321-7TH00-0AB0 
Accuracy of 10 ms

Module for acquisition of process signals:
16 inputs (NAMUR), redundant signal acquisition 
possible

ET 200M SM 326 6ES7 326-1BK02-0AB0
Accuracy from 20 to 30 ms

Module for acquisition of process signals:
● 24 Inputs for use with interface module 6ES7 

153-2BA02
● 12 inputs (CH 00 to CH 11) for use with interface 

module 6ES7 153-2BA01
● redundant signal acquisition and fail-safe signal 

acquisition possible
ET 200iSP SM 131 6ES7 131-7RF00-0AB0 

Accuracy of 20  ms
Module for acquisition of process signals:
8 inputs (NAMUR)

Modules for higher environmental requirements     
You can use functionally equivalent SIPLUS modules for higher environmental requirements.

Systems and components
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4.5 IMDRV_TS block

Using the IMDRV_TS block    
The IMDRV_TS block is a driver block. IMDRV_TS performs the following tasks for time 
stamping:

● Transmits time-stamped process signal changes to the Pcs7DiIT block

● Transmits non-specific events (special messages) to the OS

When time stamping is configured for an AS, the "Generate Module Drivers" function inserts 
IMDRV_TS automatically in a CFC chart (system chart). The names of these CFC charts 
begins with the "@" character. One IMDRV_TS is inserted for each interface module.

IMDRV_TS reads the messages from the message buffer of an interface module and transfers 
the time stamp and process signal changes to the EventTS (Page 29) block.

System messages
IMDRV_TS outputs AS process control message if an error is detected in high-precision time-
stamping.

Additional information
Additional information on the diagnostics response of the IMDRV_TS is available in the CFC 
online help for IMDRV_TS.

Systems and components
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4.6 EventTS block

Signal detection with the channel driver block
If blocks from the PCS 7 Advanced Process Library (APL) for input signals are to be given a 
high-precision time stamp, you must use the following channel driver block for signal detection: 
Pcs7DiIT.

Using blocks of the Advanced Process Library          
The EventTS block is a message block of the APL for signals with high-precision time stamping. 
Use EventTS to generate time-stamped process messages. You need to insert EventTS into 
a CFC chart when using time stamping.

EventTS has an integral alarm block (ALARM_8P). This alarm block signals a change to the 
assigned digital input.

EventTS can send messages from up to 8 digital inputs.

Additional information
You can find additional information about the messages and the response of the blocks in the 
online help for the Advanced Process Library.

Systems and components
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4.7 Time master

Time master
The time master distributes the time signal to operator stations and SIMATIC stations that need 
to be synchronized.

The following time master is recommended for PCS 7:

SICLOCK TC400

● The time master synchronizes connected stations requiring synchronization via Industrial 
Ethernet/Fast Ethernet.

● The time master can be synchronized using a time signal from a SICLOCK GPS decoder, 
or SICLOCK DCFRS receiver, for example.

Additional information
● You can find information and ordering data on the SICLOCK TM components that can be 

used in PCS 7 in the ST PCS 7 catalog (add-ons for PCS 7).

● You can find information about time synchronization for a PCS 7 plant in the function manual 
Process Control System PCS 7; Time Synchronization.

Systems and components
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Configuring Time Stamping 5
5.1 Overview of configuration tasks

Requirement
The components of the automation system are inserted in HW Config. 
The figure shows an example configuration for time stamping in HW Config:

Overview of configuration tasks

Step What?
1 Configuring the CPs: 

● Configuring the CP 443-1 (Industrial Ethernet) (Page 33) 
● Configuring the PROFINET IO connection of the CPU (Page 34) 
● Configuring the CP 443-5 Extended (Page 36) 
● Configuring the PROFIBUS connection of the CPU (Page 37) 

2 Configuring the ET 200M station:
● Power supply (no configuration necessary)
● Configuring the interface module: IM 153-2/IM 152-1 (Page 40) 
● Digital input modules:

– Configuring the SM 321 digital input module (Page 44) 
– Configuring the SM 131 digital input module (Page 47)
– Configuring the SM 326 digital input module (Page 49)

3 Configuring the symbols (Page 53) 
4 Configuring the signaling block  (Page 55) 
5 Configuring the input signals (Page 56) 
6 Configuring the messages for the high-precision time stamping  (Page 60) 
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Step What?
7 Compiling and downloading the AS (Page 61) 
8 Compiling and downloading the OS (Page 62)

Additional information
● Online help for HW Config
● List PCS 7 - released modules
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5.2 Configuring the networks

5.2.1 Configuring the networks
The following is described in this section:

● Configuring the CP 443-1 (Industrial Ethernet) (Page 33) 

● Configuring a CPU with integrated PROFINET IO connection for connecting to Industrial 
Ethernet (Page 34) 

● Configuring the CP 443-5 Extended (Page 36) 

● Configuring the PROFIBUS connection of the CPU (Page 37) 

Synchronization of the automation system
A master clock is required on the plant bus for the time synchronization of the automation 
system. We recommend you use the SINEC TC 400 master clock.

The following options are available for the interface of the automation system to the plant bus:

● Ethernet interface of the CP 443-1

● Integrated PROFINET IO connection of selected CPU types

PROFIBUS master
The PROFIBUS master is the component that distributes the system time to the PROFIBUS.

You can use the following components as the PROFIBUS master:

● CP 443-5 Extended

● Internal PROFIBUS connection of the CPU

5.2.2 How to configure the CP 443-1 (Industrial Ethernet)
The following procedure is based on SIMATIC stations connected to Ethernet via CP 443-1.

If the CPU is connected directly to Ethernet via an integrated PROFINET IO connection, the 
SIMATIC station is synchronized using NTP. Additional information is available in the section 
"How to configure the Ethernet connection for a CPU 41x PN/DP (Page 34)".

Requirement    
A CP 443-1 is configured in the configuration table for the SIMATIC station (type of CP: See 
section "Components and Systems > Communication modules (Page 25)").

Configuring Time Stamping
5.2 Configuring the networks

High-precision time stamping (V8.0 SP1)
Function Manual, 03/2013, A5E02779840-04 33



Procedure
1. Select the CP 443-1 in HW Config.

2. Select the menu command Edit > Object Properties.

3. In the "Time-of-Day Synchronization" tab, select the "Enable Time-of-Day Synchronization 
in SIMATIC Mode" check box:

4. Click "OK" to apply the settings.

5.2.3 How to configure the Ethernet connection for a CPU 41x PN/DP
The following procedure is based on SIMATIC stations in which one of the following CPU types 
are used:

● CPU 414-3 PN/DP

● CPU 416-3 PN/DP

This CPU type is synchronized via NTP. We recommend the SINEC TC 400 as the time master. 

If the CPU is connected directly to Ethernet via a CP443-1 communication processor, the 
SIMATIC station is synchronized using the SIMATIC protocol. Additional information is 
available in the section "How to configure the CP 443-1 (Industrial Ethernet) (Page 33)".
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Requirements
● The CPU is connected directly to Ethernet (plant bus).

● The time master is connected to the plant bus.

Procedure
1. Select the CPU in HW Config.

2. Select the menu command Edit > Object Properties.

3. In the "Time Synchronization" tab, activate the "Enable Time-of-Day Synchronization in 
NTP Mode" check box.

4. Click "Add".
The "Edit NTP Server Address" dialog box opens.

5. Enter the Ethernet address of the time master in the "NTP server address" text box.
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5.2.4 How to configure the CP 443-5 Extended

Requirement
A CP 443-5 Extended is configured in the configuration table for the SIMATIC station (type of 
CP: see section "Components and Systems > Communication Modules (Page 25)").

Procedure
1. Select the CP 443-5 Extended in HW Config. 

2. Select the menu command Edit > Object Properties.

3. In the "Operating Mode" tab, activate the "DP master" check box.

4. Select the "Options" tab. 

5. Activate the check box "From station to LAN" in the "Time-of-Day Synchronization" group.
By activating this option, the time frames of the time master are forwarded to the PROFIBUS 
network.

6. Click "OK" to apply the settings. 
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5.2.5 Rules for assigning the time interval
Configuration of the time interval should be noted in the following cases:

● Configuring the PROFIBUS connection of the CPU (Page 37) 

● Configuring the interface module (IM) (Page 40) 

Rules for assigning the time interval
The synchronization time interval setting depends on the interface modules (IM 153-2, 
IM 152-1) that are connected to the DP master systems:

Property Rules
IM on the DP master 
system

If only interface modules (IM) with a variable time interval (such as the 
IM153-2BA00) are used on the DP master system, set the synchronization time 
interval of the CPU to e.g. 10 seconds.

IMs with the same 
time interval (fixed or 
variable) are 
connected to the DP 
master system.

Setting for synchronization of the DP slaves:
● If all DP slaves on the DP master system expect a time interval of one 

second for the synchronization, set the time interval for the synchronization 
for the CPU to e.g. 1 second.

● If all DP slaves on the DP master system expect a time interval of ten 
seconds for the synchronization, set the time interval for the 
synchronization for the CPU to e.g. 10 seconds.

IMs with different time 
intervals (fixed or 
variable) are 
connected to the DP 
master system.

If you use interface modules (IM) with different time intervals on a DP master 
system, set the minimally required time interval for the respective DP master 
system (see rule for: IM with same time interval on the DP master system).

Rules for optimization:
Multiple 
synchronization

Avoid multiple synchronization. Set the same interval values for all 
synchronizations.
● Set the time interval for synchronization of the DP slaves.
● Set the time interval for the time master that synchronizes the plant.

5.2.6 How to configure the PROFIBUS connection of the CPU

Requirement    
The S7-400 CPU has been configured in the configuration table.

 Procedure
1. Select the PROFIBUS connection of the CPU in HW Config.

2. Select the menu command Edit > Object Properties.
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3. In the "Operating Mode" tab, activate the "DP master" check box.

4. Select the "Clock" tab.
 

  Note

The setting options in the "Clock" tab depend on the interface module (IM) used.
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5. Select "As master" in the "Synchronization mode" list . 
The time frames of the time master are then forwarded to the PROFIBUS.

 

  Note

When making a setting from the "Time Interval" drop-down list, keep in mind that the 
setting options depend on the interface modules (IM) used. 
Note the " Rules for assigning the time interval (Page 37)" section.

 

6. Click "OK" to apply the settings.
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5.3 Configuring the ET 200M station

5.3.1 Setting options on the ET 200 station

Hierarchy of Settings 

On level … ... Set in HW 
Config

Affects Setting options

DP slave
(Rack)

Interface module 
properties

All digital input 
modules in an ET 
200 station 

● Time stamping on/off
● Rising or falling edge (see section 

"Examples of settings for IM 153-2 
interface module (Page 43)")

Module Digital input 
module properties

All channels of a 
digital input module

● Time stamping on/off
● Rising or falling edge (see section 

"Examples of settings for SM 321 
digital input module (Page 46)")

Channel Digital input 
module properties

One single channel 
of a digital input 
module

● Time stamping on/off
● Rising or falling edge (see section 

"Examples of settings for SM 321 
digital input module (Page 46)")

 

 Note

The lower-level settings are overwritten by the activation/passivation at a high-level location 
(for example, on the DP slave).

 

5.3.2 How to configure the interface module

Requirements    
● A DP master system is configured on a CP 443-5 Extended or on the PROFIBUS 

connection of the CPU.

● At least one digital input module that supports time stamping is configured in the ET 200 
station (type of digital input module: See section "Components and Systems > Distributed 
I/O (Page 26)").
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Setting the synchronization interval
The synchronization interval for the CPU should be set to 10 seconds for PCS 7.

 

 Note

With some modules (for example, order no. 6ES7 153-2A... ), the synchronization interval for 
the CPU is fixed at 1 second (increased CPU load). 

 

Procedure
 

 Note

If you want to configure the digital input modules individually, open the object properties for 
the respective digital input modules. 

Additional information: 
● "How to configure the SM 321 digital input module (Page 44)" section.
● How to configure the SM 131 digital input module (Page 47)" section.

 

1. Select the interface module in HW Config.

2. Select the menu command Edit > Object Properties.

Configuring Time Stamping
5.3 Configuring the ET 200M station

High-precision time stamping (V8.0 SP1)
Function Manual, 03/2013, A5E02779840-04 41



3. In the "Name" input box on the "General" tab, enter a unique name for the interface module . 
A unique name makes it easier to assign program blocks in other configuration tasks and 
messages.

4. Open the "Time Synchronization" tab.

5. Activate the "Time synchronization" check box.
If possible, select the optimum synchronization interval.

 

  Note

When selecting the synchronization interval, note the "Rules for assigning the time 
interval (Page 37)" section.

 

6. Open the "Time-of-day Stamp" tab.
 

  Note

The "Time-of-Day Stamp" tab is available in the "Object Properties" dialog box for the 
interface module only if you have configured at least one digital input module that supports 
time stamping in the ET 200 station (see "Setting options on the ET 200 station" 
(Page 40)).

 

7. Select the "Time-of-day stamp" check box in the "Presetting of All Inputs" group.

Configuring Time Stamping
5.3 Configuring the ET 200M station

High-precision time stamping (V8.0 SP1)
42 Function Manual, 03/2013, A5E02779840-04



8. Specify the edge of the process signal from the IM that should be interpreted as an 
"incoming event". The opposite signal transition is interpreted as the signal exiting the state.
Select the check box for the required signal change:

– "Falling Edge 1 -> 0" or

– "Rising Edge 0 -> 1"

When the static state of a signal changes, a message is generated at this point in time.

9. Click "OK" to apply the settings.
 

  Note

The settings in the "DP Slave Properties" dialog box apply to all channels of the digital 
input modules with time stamping used in this ET 200 station. A change in the "Presetting 
of All Inputs" field affects the settings for all inputs of this ET 200 station.

 

5.3.3 Examples of settings for IM 153-2 interface module

1. Example
IM 153-2 - time stamping enabled for the entire ET 200M station (or only one module with time 
stamping in this ET 200M station):
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2. Example
IM 153-2 - time stamping disabled for the ET 200M station:

3. Example
IM 153-2 - time stamping enabled for (individual) modules or (individual) channels:

5.3.4 How to configure the SM 321 digital module
 

 Note

You only need to read this section if you want to set time stamp for each digital input module 
separately.    
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Requirements
● At least one ET 200M station is configured in HW Config.

● A digital input module SM 321 is configured in at least one slot of the ET 200M station 
(IM 153-2) (type of digital input module: See section "Components and Systems > 
Distributed I/O (Page 26)").

Procedure
1. In the ET 200M station, select the SM 321 digital input module for which you want to make 

the settings.

2. Open the shortcut menu (right-click) and select the menu command Object Properties.

3. Activate the "Time stamp" check box in the "Time stamping" tab and activate the radio 
button you want for RLO edge detection.

Additional information
● " Examples of settings on digital input module SM 321 (Page 46) " section

● Section "How to configure the interface module (Page 40)"
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5.3.5 Examples of settings for SM 321 digital input module

1. Example
Module setting "Presetting of all inputs" selected:

2. Example
Module setting "Individual setting of the inputs" (channel-specific) selected:

Configuring Time Stamping
5.3 Configuring the ET 200M station

High-precision time stamping (V8.0 SP1)
46 Function Manual, 03/2013, A5E02779840-04



5.3.6 How to configure the SM 131 digital module
 

 Note

You only need to read this section if you want to set time stamp for each digital input module 
separately.

 

Requirements
● An ET 200iSP station is configured in HW Config.

● A digital input module SM 131 (8 DI NAMUR) is configured in at least one slot of the 
ET 200iSP station (IM 152-1) (type of digital input module: See section "Components and 
Systems > Distributed I/O (Page 26)").

Procedure
1. In the ET 200iSP station, select the SM 131 digital input module for which you want to make 

the settings.

2. Open the shortcut menu (right-click) and select the menu command Object Properties.

3. Select the "Parameters" tab.

4. In the tree view, select the folder Parameters > Time Stamp > Individual setting of the 
inputs.
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5. In the tree view, open the folder of the channel to be changed (for example, channel 0)

6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" 
column.

7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction 
of the edge evaluation from the drop-down list box in the "Value" column.

 

  Note

You now need to configure each input separately. 

Configuration via the interface module affects all inputs of the digital input module in this 
ET 200iSP station.

 

8. Click "OK".
The settings are applied.

Additional information
● " Example of setting on digital input module SM 131 (Page 48) " section

● Section "How to configure the interface module (Page 40)"

5.3.7 Example of settings on the SM 131 digital input module
The settings can be made for all modules or specific channels.
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Example
Setting on the module:

5.3.8 How to configure the SM 326 digital input module
 

 Note

You only need to read this section if you want to set time stamp for each digital input module 
separately.   

 

Influence on a configured F system
 

 Note

The activation of the high-precision time stamping has no effect on the operation of an F 
system if the required modules and inputs have already been configured.
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Inputs available
The number of digital input module inputs available for time stamping depends on the following 
supplementary conditions:

● Version of the software package

– SIMATIC S7; S7 F systems
– SIMATIC S7; FConfigPack

● Type of interface module (IM 153-2)
High-precision time stamping is only available in SIMATIC S7-300 single modules for IM 
153-2 interface modules with the following order numbers:

– 6ES7 153-2BA01-0XB0

– 6ES7 153-2BA02-0XB0

Software packages Interface module 
6ES7 153-2BA01-0XB0

Interface module 
6ES7 153-2BA02-0XB0

FConfigPack V5.4 SP1 to V5.5 
(S7 F systems V5.2 SP4)

High-precision time stamp not available

FConfigPack V5.5 SP1 and V5.5 SP2
(S7 F systems V5.2 SP4)

12 channels available (CH00 to CH11)

FConfigPack as of V5.5 SP3
(S7 F systems V6.0)

12 channels available 
(CH00 to CH11)

24 channels available 
(CH00 to CH23)

Requirements
● An ET 200M station is configured in HW Config.

● A digital input module SM 326 is configured in a slot of the ET 200M station (IM 153-2) 
(type of digital input module: See section "Components and Systems > Distributed I/O 
(Page 26) ").

Procedure
1. In the ET 200M station, select the SM 326 digital input module for which you want to make 

the settings.

2. Open the shortcut menu (right-click) and select the menu command Object Properties.

3. Select the "Parameters" tab.

4. In the tree view, select the folder Parameters > Time Stamping > Individual setting of the 
inputs.

5. In the tree view, open the folder of the channel to be changed (for example, channel 0)

6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" 
column.
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7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction 
of the edge evaluation from the drop-down list box in the "Value" column.

 

  Note

You now need to configure each input separately. 

Configuration via the interface module affects all inputs of the digital input module in this 
ET 200M station.

 

8. Click "OK".
The settings are applied.

Additional information
● Section "Examples of settings on digital input module SM 326 section (Page 51)"

● Section "How to configure the interface module (Page 40)"

5.3.9 Examples of settings on digital input module SM 326 section
The settings for each module must be made for specific channels. 
Configuration via the interface module affects all inputs of the digital input module in this ET 
200M station.
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Example
Setting on the module:
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5.4 Configuring symbolic names

5.4.1 How to configure symbolic names for signals

Introduction
You can assign symbolic names to signals. Simple identification of the signals makes the 
interconnection of the driver blocks easier. 

Requirements
● The project is open in the Component View of SIMATIC Manager. 

● The path to the AS is set.

● HW Config is open.

Procedure
Perform the following tasks for all digital input modules:

1. Select a digital input module in HW Config. 

2. In the configuration table for the module, select a row in which an address of the process 
image is assigned. 
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3. Select the menu command Edit > Edit Symbols. 

4. Enter the symbols (symbolic names) for the assigned inputs of modules with time stamping. 
You can apply the addresses as symbols by clicking the "Add to Symbol" button. You can 
change the symbol name in the "Edit Symbols" dialog box or in the symbol table (for 
example, Symbol = "Chart_Meas" - a maximum of 24 character are allowed). 
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5.5 Configuring the signaling block

5.5.1 How to prepare for message configuration
You must configure an EventTS block in CFC charts so that messages with high-precision 
time stamps can be displayed on the OS. The EventTS block can generate the messages for 
up to 8 digital inputs.

Procedure
Create a CFC chart with a signaling block.
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5.6 Configuring the input signals

5.6.1 How to configure the input signals

Procedure         
1. Select the "PV_In" input of the channel driver block Pcs7DiITin the CFC chart.

2. Select the menu command Insert > Interconnection to Address.
The "Insert Interconnection to Address" dialog box opens.

3. Select the row with the corresponding module input and double-click in the row.

4. Connect the blocks as shown for the connections in the following examples.
 

  Note

You can configure messages assigned to the module input directly at the signaling block 
when you configure an input signal, or you can configure them later. 
You can find additional information in the section " Configuring messages for high-
precision time stamping (Page 60)").

 

  Note
Configuration for an F system

Position the EventTS block in a CFC chart that is not in the runtime group of the F blocks. 
It is not possible to forward time stamps to technology blocks via the channel driver blocks 
of the F libraries.
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Example of configuration with a technology block   
 

 Note
Making the inputs visible

You must make the following inputs of the technology blocks visible:
● EventTS block: "TimeStampOn" input

This input activates the high-precision alarm inputs when the value = 1.
● Inputs "InTS1" to "InTS8"

When technological blocks are used, these inputs additionally interconnect to the inputs 
of the technological blocks.

 

The following figure provides an example of high-precision time stamping for the "FbkRun" 
input of the "MotL" block.
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● EventTS block: Input "TimeStampOn" = 1

● The following I/Os are interconnected:

– Module, "I1.0" input with the "PV_In" input of the Pcs7DiIT channel driver block

– "PV_Out" output of the Pcs7DiIT channel driver block with the "FbkRun" input of the 
MotL block.

– "TS_Out" output of the Pcs7DiIT channel driver block with "InTS1" input of the EventTS 
block.

– EventTS block: "EventTsOut" output with the MotL block, "EventTsIn" input.
The message should be configured at the EventTS block. Replace the default text ($
$BlockComment$$ InTS1 Status 16#@1%x@) with a project-specific message text.
Example: $$BlockComment$$ <runtime error> Status 16#@1%x@

Example of configuration with the EventTS  block  
The following figure provides an example of high-precision time stamping for the "I1.0" of a 
digital input module.

● EventTS block: Input "TimeStampOn" = 1

The following I/Os are interconnected:
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● "I1.0" input of the module with the "PV_In" input of the Pcs7DiIT block

● "TS_Out" output of the Pcs7DiIT block with the "InTS1" input EventTS block

● The message should be configured at the EventTS block. Replace the default text ($
$BlockComment$$ InTS1 Status 16#@1%x@) with a project-specific message text.
Example: $$BlockComment$$ <temperature high> Status 16#@1%x@

Notes on configuration with redundant signal acquisition     
Take into account the following information for a configuration with redundant signal acquisition:

● It is possible to mix redundant and non-redundant DI signals.

● With redundant signal acquisition, a message is produced for the OS for each module input 
regardless of the module status (passivated, good status).

Additional information
You can find more information on configuration with redundant signal acquisition in the 
documentation Process Control System PCS 7; Fault-Tolerant Process Control Systems.
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5.7 Configuring messages for high-precision time stamping

5.7.1 How to configure messages with blocks of the PCS 7 Advanced Process Library 
(APL) 

Introduction
This section explains how to change the message texts at the APL block EventTS. 

Procedure
1. Open the project in SIMATIC Manager and select the menu command View > Component 

View.

2. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPU\S7 
Program\Charts.

3. Select the menu command Options > Charts > Chart Reference Data. 
The "Chart Ref: Display Chart Reference Data" dialog box opens.

4. Select the menu command View > Block Types.
The "{S7 Program} (Block Types)" dialog box opens.

5. Click "Block type" in the table heading. 
The entries are sorted alphabetically.

6. Find the EventTS block with the associated entries in the list.

7. Double-click on the block type of the messaging block in the table row found.
The CFC chart containing the block you are searching for opens. The relevant block is 
highlighted.

8. Select the menu command Edit > Object Properties.
The "Properties – Block" dialog box opens.

9. Click "Messages" in the "Special Properties" group. The "PCS 7 Message Configuration" 
dialog box opens.

10.Select the message class of the message. Change the message text in the "Event" column 
of the table (see example).

11.Click "OK".

Example
Replace the default text ($$BlockComment$$ InTS1 Status 16#@1%x@) with the project-
specific message text (for example, $$BlockComment$$ <temperature high> Status 
16#@1%x@).

Additional information
You can find additional information about message configuration in the STEP 7 online help 
under the topic "How to Create Block-Related Messages for the Project)".
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5.8 Compiling and downloading the AS

5.8.1 How to compile and download the AS

Options      
The following options are available for compiling and downloading programs:

● You can use the commands for a single SIMATIC station.

● You can compile and download multiple SIMATIC stations with a single command.

Additional information
You can find additional information and step-by-step instructions in the configuration manual 
Process Control System PCS 7; Engineering System.
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5.9 Compiling and downloading the OS

5.9.1 How to compile and download the OS

Options    
The following options are available for compiling and downloading the operator station(s):

● You can compile and download operator stations one-by-one.

● You can compile several operator stations at the same time and download them on their 
own.

● You can compile and download several operator stations at the same time.

Additional information
You can find additional information and step-by-step instructions in the configuration manual 
Process Control System PCS 7; Operator Station.
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AS Process Control Messages for Time Stamp Faults 6
6.1 Time stamp faults

Introduction
This section describes the AS process control messages that are generated when faults occur 
in the time stamping. 

Overview of AS process control messages
The following AS process control messages can be generated for time stamp faults:

● Startup data (Page 64) 

● Time-of-day message frame error (Page 66) 

● Time difference between the message frame time stamp and the real-time clock may cause 
inaccuracy (Page 67) 

● STOP of the time stamp function (Page 68) 

● Message loss at IM (buffer overflow) (Page 69) 

● Redundant changeover (Page 70) 

● Loss of information with redundancy (Page 71) 

Additional information
Additional information about editing the message texts is available in the section "Configuring 
time stamping > Configuring messages for high-precision time stamping" > How to configure 
messages with blocks of the PCS 7 Advanced Process Library (APL)  (Page 60)".
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6.2 AS process control message "Startup data"

Meaning    
The AS process control message "Startup data" indicates a start/restart of the interface 
modules (for example, IM 153-2).

Messages
● "Startup data" with the signal status "INCOMING"

● "Startup data" with the signal status "OUTGOING"

Description
1. After the start/restart, the interface module sends the signal for the AS process control 

message "Startup data" with the signal status "INCOMING" to the CPU.

2. The interface module then sends messages signaling the static state of all configured 
process signals. 
Based on the process signal, the interface module derives the signal to be sent according 
to the configuration (see following table).

3. Following this, the interface module sends the signal for the AS process control message 
"Startup data" with the signal status "OUTGOING".

Status process signal Configured edge evaluation of incoming 
event:

Interface module (signal 
message from startup)

0 0 -> 1 OUTGOING
1 0 -> 1 INCOMING
1 1 -> 0 OUTGOING
0 1 -> 0 INCOMING

Message derived from the process signal (depending on configuration)

Message processing in PCS 7
1. The signal for "Startup data" with the signal status "INCOMING" is detected and the AS 

process control message "Startup data" is entered in the message list with the signal status 
"INCOMING".

2. In the CPU, the message block compares the signal messages representing the static state 
of the process signals with the last stored state of the signals. 
If there are signals whose states are different, messages are entered in the message list 
(see following table):

3. The OS identifies the signal for the startup data. The AS process control message "Startup 
data" is entered in the message list with the signal status "OUTGOING".
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Interface module (signal 
message from startup)

Value stored in the CPU 
(message block)

Message in 
message list and archive

INCOMING INCOMING ---
INCOMING OUTGOING OUTGOING
OUTGOING OUTGOING ----
OUTGOING INCOMING INCOMING

Possible status of a message in the message list 
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6.3 AS process control message "Time-of-day message frame error"

Meaning
The AS process control message "Time-of-day message frame error" indicates an error in the 
time-of-day synchronization of the interface module (for example, IM 153-2).

Messages
● "Time-of-day message frame error" with the signal status "INCOMING"

● "Time-of-day message frame error" with the signal status "OUTGOING"

Description
The interface module expects a time-of-day frame from the time master within the configured 
interval (every second, for example). 

If the time-of-day frame of the master is not received three times in succession, the interface 
module continues to operate with the internal time and sends the message "Time-of-day 
message frame error" with the signal status "INCOMING" to the operator station. 

Once the next valid time-of-day frame arrives, the internal clock of the interface module is 
synchronized and the message "Time-of-day message frame error" with the signal status 
"OUTGOING" is triggered.
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6.4 AS process control message "Time difference between the message 
frame time stamp and the real-time clock may cause inaccuracy"

Meaning
The AS process control message "Time difference between the message frame time stamp 
and the real-time clock may cause inaccuracy" indicates a time change or time difference in 
the interface module (for example, IM 153-2).

Messages
● "Time difference between the message frame time stamp and the real-time clock may cause 

inaccuracy" with the signal status "INCOMING"

● "Time difference between the message frame time stamp and the real-time clock may cause 
inaccuracy" with the signal status "OUTGOING"

Description
The two messages are sent one after the other in the following situation:

● When a signal arrives at the interface module, there is a difference between the 
synchronous time and the internal time of the interface module.

● The difference between the times is greater than half the accuracy of the time stamp. 
Example: The difference is > 5 ms with time stamping accuracy of 10 ms. 
The time of the interface module is then synchronized.

– The message with the signal status "INCOMING" receives the time stamp before 
synchronization.

– The message with the signal status "OUTGOING" receives the time stamp after 
synchronization. 

Based on these messages, you can check whether the internal clock of the interface module 
has been set forward or back.
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6.5 AS process control message "STOP of the time stamp function"

Meaning
The AS process control message "STOP of the time stamp function" indicates a time stamp 
fault of the interface module (for example, IM 153-2).

Messages
● "STOP of the time stamp function“ with the signal status “INCOMING"

● "STOP of the time stamp function" with the signal status "OUTGOING"

Description
If the connection between the DP master and the interface module breaks down, signals are 
no longer given time stamps. The might occur, for example, following failure of the CP or a 
break on the bus cable. A message to this effect is entered in the internal message list. 

● Signal time stamping is stopped from the moment the message with the signal status 
"INCOMING" is generated.

● Signal time stamping is reactivated once the message with the signal status "OUTGOING" 
is generated.

● Once the message "STOP of the time stamp function" with the signal status "OUTGOING" 
is generated, the interface module starts up again.

AS Process Control Messages for Time Stamp Faults
6.5 AS process control message "STOP of the time stamp function"

High-precision time stamping (V8.0 SP1)
68 Function Manual, 03/2013, A5E02779840-04



6.6 AS process control message "Message loss at IM (buffer overflow)"

Meaning  
The AS process control message "Message loss at IM (buffer overflow)" indicates a loss of 
messages due to an overflow of the message buffer of the interface module .

Messages
● "Message loss at IM (buffer overflow)" with the signal status "INCOMING"

● "Message loss at IM (buffer overflow)" with the signal status "OUTGOING"

Description
The AS process control message is generated in the two following situations:

Buffer overflow due to external causes Buffer overflow due to internal causes
Examples of potential causes:
● Failure or overload of the plant or field bus
● Failure or overload of the DP master (CPU)
Remedy: Correct the source of the problem

Example of a potential cause:
The signals in the I/O change so quickly that the 
signal transitions can no longer be entered in the 
message lists.
Remedy: Distribute the signals over several 
interface modules or reduce the number of signals 
with time stamping.

 

A message to this effect is entered in the internal message list.

● Incoming messages cannot be saved from the moment the message with the signal status 
"INCOMING" is generated.

● Incoming messages can be saved again once the message with the signal status 
"OUTGOING" has been generated.
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6.7 AS process control message "Redundant changeover"

Meaning
The AS process control message "Redundant changeover" is output when there is a 
changeover between active and passive interface modules (for example, IM 153-2) .

Messages
● "Redundant changeover" with the signal status "INCOMING"

● "Redundant changeover" with the signal status "OUTGOING"

Description
The AS process control message "Redundant changeover" indicates this period of interruption.

Time stamps are not applied during the period of the failover.

● Time stamping is deactivated from the moment the message with the signal status 
"INCOMING" is generated (start of the failover between the active and passive interface 
modules).

● Time stamping is reactivated once the message with the signal status "OUTGOING" is 
generated.
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6.8 AS process control message "Loss of information with redundancy"

Meaning       
The AS process control message "Loss of information with redundancy" indicates an error 
when signals are exchanged between the passive interface module (for example, IM 153-2) 
and the active interface module.

Messages
● "Loss of information with redundancy" with the "INCOMING" signal status

● "Loss of information with redundancy" with the "OUTGOING" signal status

Description
During error-free operation, the passive interface module receives information about the 
current state of the I/O from the active interface module:

● There is a signal exchange error from the moment the message with the signal status 
"INCOMING" is generated.

● As soon as the I/O state has been synchronized between the active and passive interface 
modules, the message with the signal status "OUTGOING" is output.
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